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Overview Chapter 1 Review:

By the end of this chapter you should understand the concepts of importing audio. This Create a new session by pressing
chapter will be discussing grid and metronome options in Pro Tools. This chapter also Command + N

covers your transport window in more detail as well as your editing modes and editing

tools.

Importing Audio

Sometimes you will need to import audio files into Pro Tools from any number of
sources. The more information we can get about the file before we import the better!
Things you’ll want to look for are Sample

Rate, Bit Depth and File format.
Name ACCOUSTIC.dup...

Example of a WAV file in finder: Kind Waveform audio
Size 1.6 MB
. i Created 2015-06-21
Just by looking at the file in finder we can Modified 2015-06-21
see all the information we need before we Last opened 2015-06-21

Duration 00:11
Sample rate 48,000
Bits per sample 24

import the file into pro tools.

Now that we know some basic
information about the file we can go ahead and open our import audio file dialog box.

From the top menu bar you can Select File > Import > Audio File.
Or use the Quick Key*

You should now be looking at your import audio dialog box.

006 Open
Import Audio
< >[5z = [ED & AudioFiles 2] Q
FAVORITES cine [INST].L.wav.mdd ¥ Preview:
cine [INST).R.wav
(53 sessions 132_0Lwav
(£ Drum Samples  32_01.wav.mdd
\dup1.32_01.wav
Dropbox -
(88 orop ldup1.32_01.wav.mdd
[ Documents STIC_01.wav
Pictures ISTIC_02.wav
&t dajaun JSTIC_03.wav
£ NovEL JSTIC.01_04.wav Name ACCOUSTIC_01.wav
JSTIC.01_05.wav Kind Waveform audio
© Downloads JSTIC.01-2255_05.wav Size 553 KB on disk
) JSTIC.01-2255_06.wav Created 2015-05-30, 4:40 PM
#\; Applications STIC.01-2255 07 v Modified 2015-05-30, 4:40 PM
Type: BWF (WAV) Bit Depth: 24 ACCOUSTIC_O1.wav can be added directly to the current
Length: 0:03.697 Sample Rate: 48000 Hz session, but it will play back at the wrong speed.
Size: 5393 k Channels: 1
Clips in Current File Clips to Import
B AccousTic_o1 Add -> AACCOUSTIC_01 Convert
Add All ->
Convert All ->
Remove All Remove
Start: 0:00.000 E E g Ly 5“‘;‘ 25000
3
End: 0:03.697 irce sample rate
- CHEnETD Destination sample rate: 44100
e Quality: Tweak Head (Slow...

| New Folder Cancel | [ Done |

Within this window you can select multiple audio files to import. You’ll notice that the
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information we found earlier is also displayed here. This may NOT always be the case.
In some unique situations pro tools will not be able to identify the file type or
information. If you have established audition paths in your I/O you can even listen to
the audio files now. We will be discussing that later in this chapter. The left side of the
dialog box shows audio files you have currently selected. The right side of the dialog
box shows audio files you have marked for import. You have a choice to add, add all,
convert, or convert all of your files. Add, when available, will give you the option to
add a file to your session without copying it to the active audio files folder. This option
links the audio file to the session but DOES NOT copy it to the session. Add All does
the same thing but for all selected files.

Convert/Copy

If the file selected shows the button as copy then Pro Tools has automatically detected
that the audio file’s sample rate and bit depth are identical to that of the session. If the
Convert option is show in place of copy then you will have to pay attention to the SRC
(Sample Rate Conversion) settings. Pro Tools will automatically detect the sample rate
of the file however you can force different sample rates which is helpful if the original
recording session was clocked improperly or can be used creatively for pitch and time
effects. For the most part these settings can be ignored because Pro Tools will
automatically handle them for you. It is important to be aware of their existence in the
event you are importing sessions from multiple sources. If you are importing audio
from multiple sources you may want to import them separately, if you apply one
blanket SRC to a whole set of files you may end up importing some files incorrectly
resulting in the wrong playback speed.

Basic Navigation

Zoom in the time scale on a track: Command + ]
Zoom out the time scale on a track: Command + [
Increase Waveform size: Command + Option + ]
Decrease Waveform size: Command + Option + [

Using the scroll wheel on a mouse you can zoom in and out by holding option on the
keyboard. You can also increase or decrease the size of the waveform by holding
option + shift + scroll wheel.

The Expanded Transport Window

The expanded transport window floats around allowing you to place it anywhere on
the computer screen. Here you will also find pre and post roll controls, you can
manually input a bar beat position or a time code position. You can also define the
global tempo of a session, or instruct pro tools to follow a dynamic tempo that follows
the conductor track.

To access the transport window you can find it under the Window dropdown menu or
use the Quick Key.

Quick Keys:

Zoom In:
Command + ]

Zoom Out:
Command + [

Scroll zoom In & Out:
Option + Scroll Wheel

Increase Waveform size:
Command + Option + ]

Decrease Waveform size:
Command + Option + [

Scroll Adjust Waveform size:
Option + Shift + Scroll Wheel

Import Audio:
Command + Shift + I
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Quick Keys:

Open Transport Window:
Command + Number Pad 1

Enable Loop Playback:
Command + Shift + L

Looking at your playback and record controls you may recognize some from the top
menu transport. If you right click on the play button you will see that there are multiple

lay options. Half Speed, Prime for playback, Loop and Dynamic Transport. ..
payop P Py P Y P Definitions:

Half-Speed: This function simply plays back the audio at half the speed. Punch In/Out:

A recording technique used on
multi-track recordings where a
portion of the performance is
overdubbed onto a previously
recorded tape or hard drive, usually
overwriting any sound that had
previously been on the track used.

Prime for Playback: Prime for playback is not a persistent function, meaning it will
have to be selected every time you want to use it. The main purpose for prime for
playback is when you have sessions with large track counts that are bogging down the
system. When prime for playback is selected the computer will preload everything that
is needed for the system to play instantaneously. Pro Tools indicates that it has been
primed for playback when the stop button is illuminated.

Loop: Loop playback will continuously replay the same selection on repeat until the
user interrupts the system by pressing stop.

Record Modes:

There are 4 different record modes in pro tools all accessible by right clicking on the
record button.

Normal: Records normally without any special functions.

Loop: Loop record will continually loop over a timeline selection and automatically
record each take to a unique playlist.

Quick Punch: Quick punch puts Pro Tools in a state where it is always recording as
long as the system is playing back. When in loop record the engineer can play back the
audio previously recorded then punch in allowing whatever is currently being
performed. The engineer may then punch out returning to whatever previously
recorded material was on the track. Quick Punch is a non-destructive recording system.
Non-destructive means that nothing is lost, no audio file are erased or rewritten.
Everything will be stored and is available in the clips bin.

Destructive: Destructive recording is not recommended! This option allows you to
rewrite audio files permanently. When recording destructively previous recordings and
information are lost forever!
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Quick Keys:

Length 0] 0] 000 Toggle Quick Punch:
Command + K

2| 0] 000 Start 1| 1/ 000

Metronome Toggle:

Number Pad 7
Pre and Post Roll options.

‘When recording alone an engineer can program pre and post roll options so that the
computer can punch the recording in and out automatically. Pre and Post roll options
will follow your main counter settings which can be changed from Bars/Beats to
Minutes/Seconds, Feet/Frames, Time code or Samples.

To use pre and post roll simply enter the amount of pre-roll desired and the amount of
post roll desired. You can automatically select how much pre or post roll you want to
set by option + clicking before or after your selection.

You can toggle pre and post roll on and off with the Quick Key!

Midi Controls:

Within the midi controls on the transport
you’ll find a count off option that will count
off 2 bars or whatever you manually input
before starting playback/recording. You will
also see global meter and tempo options if
you choose not to use the conductor track.

There are four buttons across the bottom from left to right. Wait for note, Metronome,
Midi Merge, and Conductor Track.

1. Wait for note — When selected Pro Tools will wait for midi input before putting the
system into record

2. Metronome — This toggles the midi for the metronome on or off. Click to enable or
use the Quick Key!

3. Midi Merge — When midi merge is enabled pro tools will add midi to an already
existing track. When disabled pro tools will erase previous midi and write new
midi commands in.

4. Conductor Track — When enabled pro tools will follow the tempo and meter
options in the conductor track and ignore the global tempo and meter.
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Grids and Metronomes

At the top left corner of the edit window you will find all of your grid options. From
the drop down menu you can select

Bars|Beats ) Bars/Beats, Minutes Seconds,
- — Timecode, Timecode 2,

Timecode 2 01:00:00:0 Feet+Frames or Samples.
— N - Whichever of these options is
Tempo + highlighted light grey is what the

Meter

edit window will follow.

Key
Chords

Markers & Here you will also find your
tempo and meter conductor tracks.
You can input tempo and meter

changes by selecting the point in the timeline where you want to make the change.
Then clicking the plus sign beside

either the tempo or meter track. The I Tempo Change

tempo track can be expanded into a
draw view where you can pencil in
tempo changes. Pro tools also offers
Key, chord and Marker rulers where
you can input information for use later. Resolution: [I\

| Cancel | @

@ Snap To Bar
Location: m

8PM: | EX.0000 |

Tempo Changes:

After clicking the plus sign on the tempo
changes ruler the Tempo Change dialogue box will
appear.

Snap To bar tells pro tools to force the tempo change to happen on the down beat, or
on the 1 in the bar.

Location tells Pro Tools which bar/beat to put the tempo change at.
BPM (Beats Per Minute) is where you enter what you would like the new tempo to be.

Resolution identifies which note gets the beat. The default is Quarter notes. So for
example if you have the BPM at 120 you will get 120 beats per minute and each of
those beats will be identified as a quarter note on the grid.

Meter Changes:

Just as with tempo changes meter changes MetegChange

also have a snap to bar and location @ Snap To Bar
option which functions just the same. Location: | 1] 1] 000!

Meter: 4

In the meter boxes you will see two places 2
to enter integers. The top number Click: m
identifies how many beats in the bar. The

bottom number identifies what kind of l‘
note gets the beat. So the default 4/4

shows us that we will have 4 beats in the

| ok |
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bar and each of those beats will be a quarter note.

Quick Keys:

Shuffle Mode: F1

Slip Mode: F2

Spot Mode: F3

Grid Mode: F4
Edltll’lg Modes Toggle Editing Mode: ~

The click option tells the midi beat clock which notes to click on. If you have it set to
quarter note then there will be a click on every quarter note. If you have it set to an
eighth note then there will be a click on every eighth note etc.

There are 4 main editing modes in pro tools.

Shuffle Mode: This mode will dynamically move

audio in the session. When deleting or cutting a section
the audio in the selected playlist will shuffle back filling
the selected space.

Spot: Spot mode brings up a dialogue box that allows you to input exact locations for
audio clips. It also has an option to restore the audio clips to the location where they
were originally recorded.

Slip: Slip mode allows you to move audio freely within the session.

Grid: Grid mode will snap audio to the grid.

Sub Editing Modes

Absolute Grid vs Relative Grid: By default the grid mode is in Absolute mode.
Absolute mode locks audio to exact grid lines. Relative Grid will move clips that do not
begin or end on a grid relatively to another grid point without having to be exactly on
the grid. Relative grid can be handy for moving vocals around from one section to the
next where you want to maintain you position within the bar by copy it to another bar.

Shuffle Grid: Using Shuffle by itself can be dangerous because by default shuffle works
off of a slip principal. With either Shuffle or Grid selected you can hold shift and then
click the other to combine the two options. This will operate with all the rules of shuffle
mode but will snap to the grid in pro tools.

Slip Grid: Slip grid may seem silly but it is extremely useful if you find yourself
switching between the two. Enable slip grid by selecting one, holding shift and then
selecting the other. Once you’ve enabled slip grid pro tools will operate as though it is
in grid mode until you hold the Command key then it will instantly switch into slip
operation.
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Editing Tools

m  Zoomer Tool: The Zoomer Tool simply zooms the edit window to
whatever selection you make.

®m  Single Zoom: Works just like the regular zoom tool but after you use it
once it returns to whichever tool you were using previously.

®  Trim Tool: The Trim Tool can be used to trim the begginings and ends of
audio and midi clips.

®  TCE Tool: The TCE Tool appears in the dropdown menu of the trim tool.

This tool will stretch or shrink audio freely.

®  TLoop Tool: The loop tool will loop an audio or midi clip out as far as you
pull it.

m  Selector Tool: The selector tool allows you to make selections within the
edit window. Once selections are made you can cut, copy, paste or delete
them.

®m  Grabber Tool: The default grabber tool is the time grabber tool. With the
time grabber tool you can drag whole clips around in the edit window.

m  Separation Grabber Tool: Found in the grabber tool sub-menu the
separation grabber tool will automatically cut the clips at the beginning
and end of your selection so that you can then move it freely within the
edit window.

®m  Object Grabber Tool: The object grabber tool moves clips around while
maintain separations and gaps. The object grabber allows you to place
multiple clips simultaneously.

®m  Scrubber Tool: The scrubber tool will playback audio dynamically as you
drag the cursor across.

m  Pencil Tool: The pencil tool has a multitude of subsettings: Freehand,
Line, Triangle, Square, Random, Parabolic and S-Curve. The Pencil tool
can be used for repairing waveforms, drawing in automation, drawing in
midi and plenty of other places too!

Quick Keys:

Zoomer Tool: F5

Trim Tool: F6

Selector Tool: F7

Grabber Tool: F8

Scrubber Tool: F9

Pencil Tool: F10
Multi-Tool: Combination of
any two F6, F7 or F8

Cycle Editing Tools: ESC
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Quick Keys:

Zoom In:
Command + ]

Zoom Out:
Command + [

Scroll zoom In & Out:
Option + Scroll Wheel

Increase Waveform size:
Command + Option + ]

Decrease Waveform size:
Command + Option + [

Scroll Adjust Waveform size:
Option + Shift + Scroll Wheel

Import Audio:
Command + Shift + I

Open Transport Window:
Command + Number Pad 1

Enable Loop Playback:
Command + Shift + L

Shuffle Mode: F1

Spot Mode: F2

Slip Mode: F3

Grid Mode: F4

Toggle Editing Mode: ~
Zoomer Tool: F5

Trim Tool: F6

Selector Tool: F7
Grabber Tool: F8
Scrubber Tool: F9

Pencil Tool: F10
Multi-Tool: Combination of any two F6, F7 or F§
Cycle Editing Tools: ESC
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